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ELECTRONIC CIRCUIT ANALYSIS LAB
Note: The students are required to design the circuit and perform the simulation using Multisim/
Equivalent Industrial Standard Licensed simulation software tool. Further they are required to
verify the result using necessary hardware equipment.

List of Experiments :( Minimum of Ten Experiments has to be performed)
Determination of fr of a given transistor.
Voltage-Series Feedback Amplifier
Current-Shunt Feedback Amplifier
RC Phase Shift/Wien Bridge Oscillator
Hartley/Colpitt’s Oscillator
Two Stage RC Coupled Amplifier
Darlington Pair Amplifier
Bootstrapped Emitter Follower
Class A Series-fed Power Amplifier
. Transformer-coupled Class A Power Amplifier
. Class B Push-Pull Power Amplifier
. Complementary Symmetry Class B Push-Pull Power Amplifier
. Single Tuned Voltage Amplifier
. Double Tuned Voltage Amplifier

Equipment required:
Software:
I.  Multisim/ Equivalent Industrial Standard Licensed simulation software tool.

il. Computer Systems with required specifications

Hardware:

Regulated Power supplies
Analog/Digital Storage Oscilloscopes
Analog/Digital Function Generators
Digital Multimeters

Decade Résistance Boxes/Rheostats
Decade Capacitance Boxes

Ammeters (Analog or Digital)
Voltmeters (Analog or Digital)

Active & Passive Electronic Components
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la. DETERMINATION OF fr OF GIVEN TRANSISTOR
Exp. No: Date:

AIM: To determine the fr of a given transistor.

APPARATUS REQUIRED:

Name Range / Value Quantity

Regulated D.C Power supply 0-30 Volts
Transistor BC107

Resistors 1KE

Resistors 100k®,10KR, 4.7KA.
Capacitors 10mf

Potentio Meter -

Signal Generator (0—-1MHz)

Dual Trace CRO 20MHz

Bread Board and connecting wires --

o

olo|~N|olvls|w|Nk| >

CIRCUIT DIAGRAM:

IVCC=+12V

10KQ SR, 1KQSRp_

=
Common Emitier Transistor Amplifier
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MODEL GRAPH:

! -
fy Frequency (Hz)

THEORY:

Common Emitter amplifier has the emitter terminal as the common terminal between
input and output. The emitter base junction is forward biased and collector base junction is
reverse biased, so that transistor remains in active region throughout the operation. When a
sinusoidal AC signal is applied at input terminals of circuit during positive half cycle the
forward bias of base emitter junction VBE is increased resulting in an increase in 1B, The
collector current IC is increased by B times the increase in 1B, VCE is correspondingly
decreased. i.e., output voltage gets decreased. Thus in a CE amplifier a positive going signal is

converted into a negative going output signal i.e., 1800 phase shift is introduced between

output and input signal and it is an amplified version of input signal.

Characteristics of CE amplifier:
1. Large current gain (Al)
Large voltage gain (AV)
Large power gain (AP=AlL.AV)

2

3

4. Phase shift of 1800

5. Moderate input & output impedances.
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TABULAR FORM:

Input Voltage Vin=10 mV

Frequency Output Gain Gainin dB

»
Z
o

(H2) Voltage (V) AV=Vo/Vi 20 log (Av)
100
200
300
400
500
600
700
800
900
1k
2k
3k
4k
5k
6 k
7k
8 k
9k
10k
20 k
30 k
40 k
50 k
100 k
200 k
300 k
400 k
500 k
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OBSERVATIONS:
. Maximum gain (Av)
. Lower cut-off frequency (FI)
. Upper cut-off frequency (FH)
. Band width (B.W) = (FH — FL)
5. Gain bandwidth product fT= Av (B.W)

The voltage gain of the amplifier is given calculate the gain in by Gain = 20 log Av Where,
Vo is the output voltage. VS is input voltage of applied AC signal.
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PROCEDURE:

Connect the circuit as shown in the circuit diagram.

Connect the signal generator output to input terminals of the circuit and CH-1 of dual
trace CRO.

Connect the output terminal of the circuit CH-II of the dual trace CRO.

Set the power supply voltage to 9V and connect to the circuit.

Set the signal generator output sine wave of 100 Hz at 10 mV constant.
Vary the function generator frequency from 100 Hz to 500 kHz (as per in the given
tabular form) and note the corresponding output voltage.

Calculation the gain AV =Vo/Vi.
PSet the graph frequency verses gain (dB) on a semi log sheet.

RESULT:
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1b. DETERMINATION OF fr OF GIVEN TRANSISTOR (Using Simulation)

Exp. No: Date:

AIM: To determine the fT of a given transistor using simulation

APPARATUS REQUIRED:

o

Name Range / Value Quantity

Regulated D.C Power supply 0-30 Volts
Transistor BC107

Resistors 1K®A

Resistors 100k@,10K@, 4.7K0A.
Capacitors 10mf

Potentio Meter --
Signal Generator (0-1MHz)
Dual Trace CRO 20MHz

o|Nlo|v|Mlw|N| k| >

SIMULATION TOOL:
= Multisim

CIRCUIT DIAGRAM:

IVCC=+12V

100K Q2

Common Emitier Transistor Amplifier
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TABULAR FORM:

Input Voltage Vin=10 mV

Input Output
Frequency

(Hz) Voltage (V)

»
Z
o

Gain

Gain indB

AV=Vo/Vi 20 log Av

100

300

500

700

900

1k

3k

O N|O|O1 WD

5k

6 k

7k

9k

10 k

30 k

50 k

100 k

300 k

500 k

700 k

19 1M

OBSERVATIONS:
Maximum gain (Av)

Lower cut-off frequency (FI)

Upper cut-off frequency (FH)

Band width (B.W) = (FH - FL)
Gain bandwidth product fT= Av (B.W)

RESULT:
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2a. VOLTAGE SERIES FEEDBACK AMPLIFIER
Exp. No: Date:

AIM: To find the gain of the Voltage Series feedback amplifier with & without feedback.

COMPONENTS REQUIRED:

1. Transistor (NPN, Si) BC 107 : 1 No.
2. Electrolytic Capacitor 10 uF/ 25V : 2 Nos.
3. Carbon film Resistors 220 kQ, 33 kQ,100 kQ, 1 kQ : 1 No. each

MEASURING INSTRUMENTS:
1. 20 MHz Dual trace CRO

MISCELLANEOUS:

1. Trainer Module

2. 1 MHz Function Generator
3. 0-30 V 1A D.C power supply
4. Connecting wires

CIRCUIT DIAGRAM:

MODEL GRAPH:

4
Anprtude (V)

->
J Fregueney (KHz|
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THEORY:

The other name of voltage series feedback amplifier is shunt derived series fed feedback
amplifier. The fraction of output voltage is applied in series with input voltage through feedback
circuit. Feedback circuit shunt the output but in series with input. So the output impedance is

decreased while input impedance is increased. The input & output impedance of an ideal voltage

series feedback amplifier is infinite & zero respectively. The resistor RE is used to provide

necessary biasing for the amplifier with voltage series feedback gain of the amplifier decreases.

PROCEDURE:

Connect the Circuit as per the circuit diagram.

Apply a sine wave of 100 mV peak to peak amplitude at 1 kHz from signal generator to
the input of amplifier circuit.

Measure the output amplitude VO (p-p) and Calculate the gain of amplifier without
feedback by using A =VVO/VS.

Calculate the feedback factor  using AF = A / 1+Ap.
Calculate theoretically g value from B = RE / (RE+R).
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TABULAR FORM:

Input ac voltage VS =100mV p-p Vi= mV

Input
frequency
(Hz)

Output
voltage
(Volts)

Gain indB

20 log (A, 1

50

O (N[O B~ W|IN|PF
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RESULT:
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2b. VOLTAGE SERIES FEEDBACK AMPLIFIER (Using Simulation)

Exp. No: Date:

AIM: To find the gain of the Voltage Series feedback amplifier with & without feedback using
Simulation.

COMPONENTS REQUIRED:

4. Transistor (NPN, Si) BC 107 : 1 No.
5. Electrolytic Capacitor 10 uF/ 25V : 2 Nos.
6. Carbon film Resistors 220 kQ, 33 kQ,100 kQ, 1 kQ : 1 No. each

MEASURING INSTRUMENTS:
1. 20 MHz Dual trace CRO

MISCELLANEOUS:
5. Trainer Module

6. 1 MHz Function Generator
7. 0-30V 1A D.C power supply

SIMULATION TOOL:
= Multisim

CIRCUIT DIAGRAM:
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TABULAR FORM:

Input ac voltage VS =100mV p-p Vi= mV

Input frequency
(Hz)

Output
voltage(V)

A
Ay

Gain o
= y/1 GainindB
20 log{A,)

50

100

150

200

500

1k

3k

5k
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PROCEDURE:

Connect the Circuit as per the circuit diagram.

Apply a sine wave of 100 mV peak to peak amplitude at 1 kHz from signal generator to

the input of amplifier circuit.

Measure the output amplitude VO (p-p) and Calculate the gain of amplifier without
feedback by using A =VVO/VS.
Calculate the feedback factor 3 using AF = A/ 1+Ap.

Calculate theoretically g value from g = RE / (RE +R).

RESULT:
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3a. CURRENT SERIES FEEDBACK AMPLIFIER

Exp. No: Date:

AIM:
1. To study the current shunt feedback amplifier
2. To measure the voltage gain of the amplifier at 1 KHz.
3. To obtain the frequency response characteristic and the band width of the
amplifier.

APPARATUS:

Name Range / Value Quantity

Regulated Power Supply (0-30V) 1

Transistor BC 107 1

Resistors 100K[@,4.7KE,10KA

Resistors 1K@ -2

Capacitors 108F -3

Function generator -

CRO --

CIRCUIT DIAGRAM:

WITHOUT FEEDBACK:

Without feedhack Amplifier
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WITH FEEDBACK:

MODEL GRAPH:

THEORY:

With feedback Anmplifier

/i Without feedback

With feedback

fy fy Frequency

Feedback plays a very important role in electronic circuits and the basic parameters,

such as input impedance, output impedance, current and voltage gain and bandwidth, may be

altered considerably by the use of feedback for a given amplifier. A portion of the output signal

is taken from the output of the amplifier and is combined with the normal input signal and

thereby the feedback is accomplished.

There are two types of feedbacks. They are i) Positive feedback and ii) Negative

feedback. Negative feedback helps to increase the bandwidth, decrease gain, distortion, and

noise, modify input and output resistances as desired. A current shunt feedback amplifier

circuit is illustrated in the figure. It is called a series-derived, shunt-fed feedback. The shunt

connection at the input reduces the input resistance and the series connection at the output

increases the output resistance. This is a true current amplifier.

Dept.of ECE
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PROCEDURE:

AMPLIFIER WITHOUT FEED BACK:

1.
2.

6.
7. Draw a graph between the frequency and the gain in decibels and determine the

Connect the circuit as shown in the figure — 1.
Apply a 20 mV sinusoidal signal at a frequency of 100 Hz and observe the I / P
signal in the C.R.O.

3. Determine the O / P voltage Vo using the C.R.O.
4.
5. Now vary the frequency in convenient steps upto 1MHz keeping the 1/ P constant

Determine the gain of the amplifier Av = Vo / V.

and for each frequency note down the O/ P voltage.
Tabulate the readings.

band width.

AMPLIFIER WITH FEEDBACK:

. Connect the circuit as shown in the figure — 2.
. Apply a 20 mV sinusoidal signal at a frequency of 100 Hz and observe the I / P

signal in the C.R.O.

. Determine the O / P voltage Vo using the C.R.O.
. Determine the gain of the amplifier with feedback Avi= Vo / Vi.Compare this

gain with the gain of the Amplifier without feedback.

. Now vary the frequency in convenient steps up to 1MHz keeping the I/ P constant

and for each frequency note down the O / P voltage.

. Tabulate the readings.

. Draw a graph between the frequency and the gain in decibels and determine the
band width. Compare the band width with the band width of the Amplifier without
feedback.
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TABULAR FORM:
Vi=20mV

Without Feedback With Feedback

Frequency

(Hz) Gain Gain in db Gain

Avs Gainindb

Av=Vo/Vi | (20logAv) “VolV, (20logAv)

50

1M

RESULT:

Gain of the Amplifier without feedback at 1 kHz is Av
Gain of the Amplifier with feedback at 1 kHz is  Avs
Band width of the Amplifier without feedback

Band width of the Amplifier with feedback

VIVA QUESTIONS:

1. What are the different types of feedback techniques?

2. What is the type of feedback incorporated in oscillators?

3. What are the advantages of negative feedback?

4. Why positive feedback is not used in amplifiers?

5. What is the expression for the de-sensitivity factor in case of negative feedback?

6. What happens to the band width of an amplifier if we incorporate negative
Feedback?
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3b. CURRENT SERIES FEEDBACK AMPLIFIER (Using Simulation)

Exp. No: Date:
AIM: To Set the frequency response curve of an amplifier with and without feedback.

APPARATUS:

S. No Name Range / Value Quantity

Regulated Power Supply (0-30V) 1
Transistor BC 107 1
Resistors 100K, 10K®
Resistors 1K@
Capacitors 10@F

Function generator --
CRO --

SIMULATION TOOL.:
= Multisim

THEORY:

When any increase in the output signal results into the input in such a way as to cause the
decrease in the output signal, the amplifier is said to have negative feedback. The advantages of
providing negative feedback are that the transfer gain of the amplifier with feedback can be stabilized
against variations in the hybrid parameters the transistor or the parameters of the other active devices
used in the circuit. The most advantage of the negative feedback is that by proper use of this, there is
significant improvement in the frequency response and in the linearity of the operation of the amplifier.

The main disadvantage of the negative feedback is that the voltage gain is decreased. In
Current-Series feedback, the input impedance of the amplifier is increased and the output impedance is
also increased. Noise and distortions are reduced considerably.

PROCEDURE:

AMPLIFIER WITHOUT FEEDBACK:
1. Connect the circuit as shown in figure — 1.

2. Applya 20mV sinusoidal signal at a frequency of 100Hz and observe the I/P waveform
in the CRO.
Determine the O/P Voltage Vo using the CRO.
Determine the gain of the amplifier Av = Vo/Vi.
Now vary the frequency in convenient steps up to 1MHz keeping the I/P constant and for
each frequency note down the O/P voltage.

. Tabulate the readings.

Draw the graph between the frequency and the gain in decibels and determine the band

width.
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CIRCUIT DIAGRAM:

WITHOUT FEEDBACK:

R1
A

Vi1

T 10mvVrms
'\.,>1 kHz

- 00

1kQ

BC107BP

R5
1kQ

Li

Amplifier without feedback

Input and Output waveforms:

] '/\ / /ﬂ.\ & 7
\// \ ,/ \ J-Aa \\/’ \/ L

/
/

T Tt T T T

\/‘ f\/\/

\

<

Time
Tl 4= = 1740 =

T2 [€| 1.750s
T2T1 1.042 ms

Timebase
Scale: | 1ms/Div

X pos.(Div): | 0
[¥/r]add | [B/A | A

Dept.of ECE

Channel_A Channel_B
941,416 mV 13.985mV Reverse
-794.145mV 13,200 mV

147.271mV -785.011uV Save

Channel A ~ Channel B Trigger

| ‘scale: Il V/Div Scale: [20 m\'/D'V Edge: [F]% [E

Ext. trigger

b:._f

Y pos.(Div): | -1.2 Y pos. (Div): (1.4 | Level: [ 0

v ]

AC O AC 0 - Single | Normal || Auto

None |
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AMPLIFIER WITH FEEDBACK:

1. Connect the circuit as shown in figure — 2.
2. Apply a 20mV sinusoidal signal at a frequency of 100Hz and observe the I/P
Waveform in the CRO.

3. Determine the O/P Voltage Vo using the CRO.

4. Determine the gain of the amplifier Avf = Vo/Vi. Compare this gain with the gain
of the Amplifier without feedback.

5. Now vary the frequency in convenient steps up to 1MHz keeping the I/P constant
and for each frequency note down the O/P voltage.

6. Tabulate the readings.

7. Draw the graph between the frequency and the gain in decibels and determine the
band width. Compare the band width with the band width of the Amplifier without
feedback.

RESULT & DISCUSSION:
Gain of the Amplifier without feed back at Av =
Gain of the Amplifier with feedback at Avf
Band width of the Amplifier without feedback
Band width of the Amplifier with feedback =

WITH FEEDBACK:

R1

A
1kQ
V1 BC107BP
. 20mVrms
w>1kl<ll R5
0° §1m

1

Amplifier with feedback
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Input and Output waveforms:

<

T1 € > Time Channel_A Channel_B )
2.911s 55,770 mV -14.042 mV Reverse

T2 [« 29125 55.625 mV -14.006 mV
T2T1 1.004 ms -144.771 WV 35.993 uV Save e

Timebase Channel A Channel B Trigger
Scale: | 1ms/Div Scale: l 50 mV/Div Scale: ’ 20 mV/Div Edge: [F]% E' 8 lExt

X pos.(Div): | 0 Y pos.(Div): | -1.2 Y pos.(Div): | 1.4 Level: [0 ! ]
Add | |B/A |A/B AC|l O AC!l o L Single || Normal || Auto

MODEL GRAPH:

-
L
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Frequency Response:

B QW

cunan! sanaes feod back ampiher
AC Analysis

Q3 O m % N s =
Frequency response without feed back

BRENANY A B ighe

X | - - ' - L T

GTant Senes food Dok amplfer
AC Analyan

Frequency response with feed back

. LA
AC Annlysin{Mergod 1)
A Analiva s

1 anhan s if Fon wmgoma wd bos | donn 8 gen

Comparison between Without and With feedbacks in terms of gain and bandwidth
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TABULAR FORM:

Without Feedback With Feedback
Frequency

(H2) Vo Gain Gainindb | O/P Vo Gain Gain in db
(Volts) Av=Vo/Vi (20logAv) (Volts) Avi=Vo/V| (20logAv)

50

1K
3K
5K
7K
10K
30K
S0K
70K
100K
300K
500K
700K
1MHz
10 MHz
100 MHz

Gain and Bandwidth of Current series feedback amplifier

Max Gain: 3dB Gain: B.W. Without feedback:

Max Gain: 3dB Gain: B.W. With Feedback:

Dept.of ECE
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4a. WIEN BRIDGE OSCILLATOR

Exp. No: Date:

AIM: To determine the frequency of oscillations of a given Wien Bridge oscillator and compare
it with the theoretical value.

APPARATUS:

S. No Name Range / Value Quantity

Regulated Power Supply | [- 15V -0V - +15V] 1
OPAMP A741C 1
Potentiometer 47 K 1
Resistors 3.3 K@, 2200
Resistors 12 K&
Capacitors 0.047@ F, 0.33@ F
CRO.

CIRCUIT DIAGRAM:

\k
pATAICTSO
e
+15V

A /\R/\ _Ui

—C

Wien Bridge Oscillator

OUT PUT WAVE FORM:

AWAWAWAWA

Al p iyl
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TABULAR FORM:

Theoretical Practical
Frequency = 1/(2@ RC) Frequency=1/T
(Hz) (Hz)

Capacitance Resistance
C(@F) R Q)

0.047 3.3K

0.33 220

THEORY

The circuit diagram of Wien bridge oscillator is given in figure .The circuit consists of a
two stage RC coupled amplifier which provides a phase shift of 360 © or 0°. A balanced bridged is
used as the feedback network which has no need to provide any additional phase shift. The
feedback network consists of lead-lag network (R:-C1and R2-Cz) and a voltage divider. The lead—
lag network provides positive feedback to the input of first stage and the voltage divider provides
a negative feedback to the emitter of Q1. If the bridge is balanced,

where Xc1 and Xc2 are the reactance of the capacitors.

By simplifying and equating the real and imaginary parts on both sides, we get the
frequency of oscillation as, the ratio of Rs3 to R4 being greater than 2 will provide a sufficient gain
for the circuit to oscillate at the desired frequency. This oscillator is used in commercial audio
signal generator.

PROCEDURE:

ll_':l?\/

. Connect the circuit as shown in the flgure
&anect 0.047@F,and 3.3 K@ i EPIGWPI € alru R: ]\
nal

and measure

=~ RO

=
- 47K

e

?

=Coffhieet'the O/P to the C.R.O and obserye the sinusoidal

its frequency. RS P S e <

Connect 0.33 AL, and 220 @ in jifaces and R.
.|Obset¥&the sinusoiddl signal ang measure its frequency.
6] Tabulate/the reatiings|and Compare it retical values
U(.fl:ll1 ul— B g c3 }f C4
| |

QMU_AS Sk 11

> 10yF 1 Py 100F
WP%actlcahEiaquenqy f,=
NAN

-

Thebretical Freguiency o =

T

1
’,QIR

RESULT:
Theoretical frequency
Practical frequency

CIRCUIT DIAGRAM - 2:
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4b. WIEN BRIDGE OSCILLATOR (Using Simulation)

Exp. No: Date:

AIM: Design and generate a sine wave for different RC values (Wien Bridge oscillator) by
using Simulation software.

APPARATUS:

Name Range / Value Quantity

Regulated Power Supply | [- 15V -0V - +15V] 1
OPAMP AT741C 1
Potentiometer 47 K 1
Resistors 3.3 K@, 2207
Resistors 12 K&
Capacitors 0.047@ F, 0.33@ F
CRO. --

SIMULATION TOOL:
= Multisim

CIRCUIT DIAGRAM:

471%
~15V
Ny
pATAICTSO
el
+15V

AVAYAY
R

—_C

Wien Bridge Oscillator
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OUT PUT WAVE FORM:

A {4

TRAAAAN
IRVRVAVAVAR

p—

PROCEDURE:

Connect the circuit as shown in the circuit diagram.
Connect the output terminal of the circuit to Channel — 1 of the dual trace CRO.

Simulate, adjust the potentiometer (i.e., 12 kQ variable resistance) to get the correct sine
wave form. Place the both cursers in the CRO observe the T2— T1 asT.

PSet the graph for the obtained frequency
OBSERVATIONS:

Frequency of oscillations:

GRAPH:

PSet the observed output on a graph sheet.

RESULT:

CIRCUIT DIAGRAM - 2:

pot
4' ’7 %
= (0-1000KO

RS
BBKO
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Exp. No:

5a. RC-PHASE SHIFT OSCILLATOR

Date:

AIM : To determine the frequency of oscillations of a given RC phase shift Oscillator,

APPARATUS:

S. No

Name

Range / Value

Quantity

DC Regulated power supply

(0—30V)

1

Transistor

BC 107

1

Resistors

1K®, 47K@3, 5608

Resistors

4.7KH

Capacitors

0.12F, 0.012F, 0.001&F

Capacitors

0.047@ F

Capacitors

CIRCUIT DIAGRAM:

T Yee=9V

100 @F
20V

4TK Q) % 47KQ) %
0.047 uF

&

N

4.‘?KQ§ 5600%

RC-Phase shift Oscillator
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PROCEDURE:
. Connect the circuit diagram as shown in the figure.
2. Switch on the power supply.
3. Connect the O/P terminals to C.R.O.
4. Observe the sinusoidal wave form on C.R.O.
5. Determine the time period (T) of the wave form and frequency (1/T).
6. Repeat the above procedure for different sets of Capacitors.
7. Tabulate the readings and compare with theoretical values.

TABULAR FORM:

Resistance Capacitance Practical Theoretical
(K@) (BF) Frequency (Hz) Frequency (Hz)
4.7 0.1
4.7 0.01
4.7 0.001

CALCULATIONS:

f (practical) = 1/T Hz.

1
£ =
° " 2BRC B+ 4K

(Theoretical) Where K=Rc/R =1.

Ri=R=R3=R.
Ci1=C,=Cs3=C.

RESULT:
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5b. RC-PHASE SHIFT OSCILLATOR (Using Simulation)

Exp. No:

PRELAB:

Date:

1. Study the different types of oscillator and their necessary conditions.
2. Identify all the formulas required to calculate frequency.

OBJECTIVE:

1. To simulate RC phase shift oscillator in Multisim and study the transient response.
2. To determine the phase shift of RC network in the circuit.

SOFTWARE TOOL:
e Multisim.

APPARATUS:

S. No Name

Range / Value

Quantity

DC Regulated power
supply

(0 - 30V)

Transistor

BC 107

Resistors

1K@, 47K@, 5602

Resistors

4.7KH@

Capacitors

0.1aF, 0.01&F, 0.0012F

Capacitors

0.047@ F

Capacitors

THEORY:

100 BF
20V

The basic RC Oscillator which is also known as a Phase-shift Oscillator, produces a sine
wave output signal using regenerative feedback obtained from the resistor-capacitor combination.
This regenerative feedback from the RC network is due to the ability of the capacitor to store an
electric charge, (similar to the LC tank circuit).

This resistor-capacitor feedback network can be connected as shown above to produce a
leading phase shift (phase advance network) or interchanged to produce a lagging phase shift
(phase retard network) the outcome is still the same as the sine wave oscillations only occur at the
frequency at which the overall phase-shift is 360e.

By varying one or more of the resistors or capacitors in the phase-shift network, the
frequency can be varied and generally this is done by keeping the resistors the same and using a 3-

ganged variable capacitor.

If all the resistors, R and the capacitors, C in the phase shift network are equal in value,
then the frequency of oscillations produced by the RC oscillator is given as:

Where:
fr is the Output Frequency in Hertz

R is the Resistance in Ohms
C is the Capacitance in Farads

Dept.of ECE
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N is the number of RC stages. (N = 3)

CIRCUIT DIAGRAM:

RC PHASESHIFT OSCILLATOR

OBSERVATIONS/GRAPHS:
C1=C2=C3=0.001p

Soes
Exl, o=
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K Dos. (av) o (T Y oo (D) B Leved) n | v '
[Vim| e | Bya || agm e | ac | o l[&€] Singn | Nacmal | Auta (Mo |

10 044 kKH=Z |

Messuyement Sensitvity (RMsH
I ér‘.a - Pocicad ' 1

Trigger level
l 0

Coupling EZl Slew change agral

Fuilnes AP e 1

CoOmDreammonm rate:

-
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Since the resistor-capacitor combination in the RC Oscillator circuit also acts as an attenuator
producing an attenuation of -1/29th ( Vo/Vi = B ) per stage, the gain of the amplifier must be
sufficient to overcome the circuit losses. Therefore, in our three stage RC network above the

amplifier gain must be greater than 29.

The loading effect of the amplifier on the feedback network has an effect on the frequency
of oscillations and can cause the oscillator frequency to be up to 25% higher than calculated. Then
the feedback network should be driven from a high impedance output source and fed into a low

impedance load such as a common emitter transistor amplifier but better still

an Operational Amplifier as it satisfies these conditions perfectly.

PROCEDURE:

1. Open Multisim Software to design RC Phase shift oscillator

2. Select on New editor window and place the required component on the circuit

window.

3. Make the connections using wire and check the connections of oscillator.

4. Go for simulation and using Run Key observe the output waveforms on CRO

5. Observe the Transient Response and Calculate the Frequency of the oscillator

Theoretical calculations:

f(practical) = 1/T Hz.

1
f=
° " 2BRC6+ 4K

(Theoretical)

Results and Discussions:

Where K=R¢/R =1.

Ri=R;=R3=R.
C1=C2=C3=C.

C(2F)

Practical

C

frequency
(Hz)

Theoretical
Frequency
(H2)
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C1=C2=C3=0.01p

." llv‘ “.| " '..l ;.‘I 4‘.I |
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. i)
X poe. Div)
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1.096 kHz ‘

Sensitivity RMS)

Measurement

I Freg FPencd ; 1

Trigger level

Pulze Rise/Fall 3
|

Coupling [F]slow chang=s sgral

I AC Compreggion rate:

-

C1=C2=C3=0.1y, ...

REVIEW QUESTIONS:

. What are the conditions of oscillations?
. Give the formula for frequency of oscillations?
. What is the total phase shift produced by RC ladder network?

. What are the types of oscillators?
. What is the gain of RC phase shift oscillator?

EXERCISE:

1. Design RC Phase shift oscillator using FET and different design values

2. Design a PCB layout for RC Phase shift oscillator.

*k*k
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Exp. No:

6a. COLPITTS OSCILLATOR

Date:

AIM: To determine the frequency of oscillations of a given Colpitts Oscillator.

APPARATUS:

S. No

Name

Range / Value Quantity

DC Regulated Power Supply

(0-30V)

Resistors

5602-1, 47 K&-1

Resistors

4.7 KB-2

Capacitors

100@F-1, 0.047EF-1

Decade Inductance Box

Decade Capacitance Box

CRO

CIRCUIT DIAGRAM:

T Voo=9V

47K Q) % 47KQ %
0.047 uF

{I o Yo

£

4.-,.m§ 5600% -

OUTPUT WAVEFORM:

Aenp )

Colpitis Oscillator
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TABULAR FORM:

L (mH)

Practical

frequency
(H2)

Theoretical
Frequency
(H2)

1

2
3

THEORY:

In the Colpitts oscillator shown in figure, Z1, and Z2 are capacitors and Z3 is an inductor.
The resistors R and R2 and RE provide the necessary DC bias to the transistor. CE is a bypass
capacitor CC1 and CC2 are coupling capacitors. The feedback network consisting of capacitors
C1 and C2, inductor L determine the frequency of the oscillator.

When the supply voltage +VCC is switched ON, a transient current is produced in the

tank circuit, and consequently damped harmonic oscillations are setup in the circuit. The current
in tank circuit produces AC voltages across C1 and C2. As terminal 3 is earthed, it will be at zero

potential.

If terminal is at positive potential with respect to 3 at any instant, then terminal 2 will be
at negative potential with respect to 3 at the same instant. Thus the phase difference between the

terminals 1 and 2 is always 1800. In the CE mode, the transistor provides the phase difference of
1800 between the input and output. Therefore the total phase shift is 3600. The frequency of
oscillations is

1 1
f = ——=———where =
ITT,‘I-LCHU g

(]

1
(2

PROCEDURE:

Connect the circuit diagram as shown in the figure.

Switch on the power supply.
. Connect the out put terminals to CRO.
. Adjust the capacitances until a sinusoidal wave form is observed on the CRO.
. Measure the time period of the sinusoidal wave form (T) and determine the

Frequency (1/T).
. Repeat the above steps for different values of L, C1 & Co.

7. Tabulate the readings and compare with theoretical values

CALCULATIONS:
fo (practical)

fo (theoretical)

=1/T Hz.
f =

0 z,yceq |

cC

[WhereC
eq =C lFC 1
1 2

RESULT:
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6b. COLPITTS OSCILLATOR (Using Simulation)

Exp. No: Date:

PRELAB:

Study the operation and working principle Hartley oscillator.

OBJECTIVE:

To design Colpitts oscillator using Multisim software and calculate the
frequencyfor different LC Values

SOFTWARE TOOL:
= Multisim

APPARATUS:

S. No Name Range / Value Quantity

DC Regulated Power Supply (0-30V)
Resistors 5600, 47 K@
Resistors 4.7 K@
Capacitors 100@F, 0.0472F
Inductor(Variable Type)
Capacitors

CRO

THEORY:

A Colpitts oscillator is the electrical dual of a Hartley oscillator, where the feedback signal is

taken from inductive voltage divider consisting of two coils in series (Tapped inductor) below figure

shows the Colpitts circuit. L and the series combination of C1 and Cz form the parallel resonant tank

circuit which determines the frequency of the oscillator. The voltage across C2 is applied to the base-
emitter junction of the transistor, as feedback to create oscillations. Here the voltage across Ci1 provides
feedback. The frequency of oscillation is approximately the resonant frequency of the LC circuit,

which is the series combination of the two capacitors in parallel with the inductor
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CIRCUIT DIAGRAM:
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PROCEDURE:

Connect the circuit diagram as shown in the figure.

Switch on the power supply.

1
2
3. Connect the output terminals to CRO.
4

Adjust the capacitances until a sinusoidal wave form is observed on the

CRO.

. Measure the time period of the sinusoidal wave form (T) and determine the

Frequency (1/T).

6. Repeat the above steps for different values of L, C1& Co.
7. Tabulate the readings and compare with theoretical values

RESULTS &DISCUSSIONS:

C1=C2=10u; L=3u

b &

[y ] Acd | men

39 153 kHz I

Measurement

|  Freq | Period
Pulse Rise /F sl

Coupling

Dept.of ECE

Senmtivity (RMS)
|1 [mv |

Trigger level

|0 5y |

4] slow change signal
Compreszion rate:

-

-
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C1=C2=10u; L =5u

N A ) I A & AANAAAANANAN
‘ llllll.l"'lll J AWANARAWARAWA WANE
. \ etal b g} fotodod L LAl L3 LY, | -
Vv \ \ " _' ) " P ' \ ,' \ ‘J ﬁ' ] l|“' |'. J \ J "|‘l Illll ll‘ll Iu) ‘.; "\"‘ l.'.

30 028 kHzZ |

Measurement Sensitivity (RMS)
| Frea | Pariod | 1

TriQoer level

Pulse Rise/Fall l =

Coupling l:"” Zlow change sigral

[ AC : COMPression rate)

Formulae: _
fo (practical) =1/T Hz.

fo (theoretical) f0 =

28 [LCeq
TABULAR FORM:

C(aF) Practical Theoretical
S.NO. L (mH) frequency Frequency
C1 C2 (Hz) (Hz)

Theoretical calculations:

Dept.of ECE Il (B.Tech) ECE,II-SEM :: ECA-Lab




41

7a. HARTLEY OSCILLATOR
Exp. No: Date:

AIM: To Determine the frequency of oscillations of a Hartley Oscillator and

compare it with the theoretical values.

APPARATUS:

S. No Name Range / Value Quantity

D.C Regulated Power Supply (0-30V) 1
Resistors 1KQ, 10kQ, 47KQ
Capacitors 0.22pF -2 1
Decade Capacitance Box
Decade Inductance Box
CRO

CIRCUIT DIAGRAM:

Harley Oscilkater

THEORY:

In the Colpitts oscillator shown in figure, Z1, and Z2 are inductor and Z3 is an capacitors.
The resistors R and R2 and RE provide the necessary DC bias to the transistor. CE is a bypass
capacitor CC1 and CC2 are coupling capacitors. The feedback network consisting of capacitors
C, inductor Ly and L2 determine the frequency of the oscillator.

When the supply voltage +VCC is switched ON, a transient current is produced in the

tank circuit, and consequently damped harmonic oscillations are setup in the circuit. The current
in tank circuit produces AC voltages across L1 and L2. As terminal 3 is earthed, it will be at zero
potential.
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If terminal is at positive potential with respect to 3 at any instant, then terminal 2 will be
at negative potential with respect to 3 at the same instant. Thus the phase difference between the

terminals 1 and 2 is always 1800. In the CE mode, the transistor provides the phase difference of

1800 between the input and output. Therefore the total phase shift is 3600. The frequency of
1

28, [LeaC

oscillationsis fo =

PROCEDURE:

1. Connect the circuit as shown in the figure.

2. Connect the O / P of the oscillator to the C.R.O.

3. Adjust the Capacitance and Inductance Boxes until a sinusoidal signal is observed
In the CRO.

4. Determine the frequency of the wave form.

5. Vary the Capacitance in convenient steps and determine the frequency each time

6. Tabulate the readings and compare the readings with the theoretical values.

FORMULAS:

Theoretical Frequency

Practical Frequency

CALCULATIONS:

TABULAR FORM:

Inductance
Capacitance (mH) Practical Theoretical

C(aF) L, L, Frequency (Hz) Frequency (Hz)

RESULT:
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7b. HARTLEY OSCILLATOR (Using Simulation)

Exp. No: Date:

PRELAB:
Study the operation and working principle Hartley oscillator.

OBJECTIVE:

To design Hartley oscillator using Multisim software and calculate the frequency

SOFTWARE TOOL.:
= Multisim 13.0
APPARATUS:

S. No Name Range / Value Quantity

D.C Regulated Power Supply (0-30V) 1
Resistors 1KQ, 10kQ, 47KQ
Capacitors 0.22uF

Decade Capacitance Box
Decade Inductance Box
CRO

THEORY:

The Hartley oscillator is an electronic oscillator circuit in which the oscillation frequency is
determined by a tuned circuit consisting of capacitors and inductors, that is, an LC oscillator. The
Hartley oscillator is distinguished by a tank circuit consisting of two series-connected coils (or, often, a
tapped coil) in parallel with a capacitor, with an amplifier between the relatively high impedance
across the entire LC tank and the relatively low voltage/high current point between the coils. The
Hartley oscillator is the dual of the Colpitts oscillator which uses a voltage divider made of two
capacitors rather than two inductors. Although there is no requirement for there to be mutual coupling
between the two coil segments, the circuit is usually implemented using a tapped coil, with the
feedback taken from the tap, as shown here. The optimal tapping point (or ratio of coil inductances)

depends on the amplifying device used, which may be a bipolar junction transistor.
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CIRCUIT DIAGRAM:
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PROCEDURE:

1. Connect the circuit as shown in the figure.

2. Connect the O / P of the oscillator to the C.

R.O.

3. Adjust the Capacitance and Inductance Boxes until a sinusoidal signal is observed

in the CRO.

4. Determine the frequency of the wave form.

5. Vary the Capacitance in convenient steps and determine the frequency each time

6. Tabulate the readings and compare the readings with the theoretical values.

FORMULAS:

Theoretical Frequency

Practical Frequency

RESULT & DISCUSSIONS:

L1=L2=200u; C = 40nf
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L1=L2=200u; C = 80nf
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Inductance

Capacitance (mH)
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Theoretical calculations:
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8a. TWO STAGE RC-COUPLED AMPLIFIER
Exp. No: Date:

AIM: To pSet the frequency response of Two stage RC — Coupled Amplifier and to obtain its
band width.

APPARATUS:

S. No Name Range / Value Quantity

1 D.C Regulated power supply | (0 —30V) 1
2 Transistors BC 107 2
10KQ, 150KQ, 47KQ,
Resistors 22KQ, 33KQ,
2.2KQ,1KQ, 560Q, 220Q
Resistors 4.7KQ

Capacitors 10uF

Function Generator --

CRO --

CIRCUIT DIAGRAM:
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THEORY

As the gain provided by a single stage amplifier is usually not sufficient to drive the load,
so to achieve extra gain multi-stage amplifier are used. In multi-stage amplifiers output of one-
stage is coupled to the input of the next stage. The coupling of one stage to another is done with
the help of some coupling devices. If it is coupled by RC then the amplifier is called RC-coupled
amplifier.

Frequency response of an amplifier is defined as the variation of gain with respective
frequency. The gain of the amplifier increases as the frequency increases from zero till it becomes
maximum at lower cut-off frequency and remains constant till higher cut-off frequency and then
it falls again as the frequency increases.

At low frequencies the reactance of coupling capacitor CC is quite high and hence very
small part of signal will pass through from one stage to the next stage. At high frequencies the
reactance of inter electrode capacitance is very small and behaves as a short circuit. This
increases the loading effect on next stage and service to reduce the voltage gain due to these
reasons the voltage gain drops at high frequencies.

At mid frequencies the effect of coupling capacitors is negligible and acts like short circuit,
where as inter electrode capacitors acts like open circuit. So, the circuit becomes resistive at mid
frequencies and the voltage gain remains constant during this range.

PROCEDURE:
. Connect the circuit as shown in the figure.
. Switch on the power supply and the Function generator.
. Apply a 5mV sinusoidal signal at the I/P.
. Vary the frequency in convenient steps and note down the O/P voltage.
. Tabulate the readings and calculate the gain in dB.
PSet a graph between gain and frequency.
Determine the band width.

TABULAR FORM:
Vi=20mV

Frequency Voltage Gain GainindB
(H2) Av=(Vol/Vi) (20logAv)

»
Z
)

50
100
300
500
700
1K
3K
5K
7K
10K
30K
50K
70K

100K
300K
500K
700K
1MHz

PlRRR R Re ke
o N|o| Ul B W[N] k| O © R N[O 1 & W N =
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RESULT:

Upper cut-off frequency
Lower cut-off frequency
Bandwidth

8b. TWO STAGE RC-COUPLED AMPLIFIER (Using Simulation)

Exp. No: Date:

PRELAB:

1. Study the purpose of multistage amplifiers.

2. Learn the different types of coupling methods.

3. Study the effect of cascading on Bandwidth.

4. ldentify all the formulae you will need in this Lab.

5. Study the procedure of using Multisim tool (Schematic & Circuit File)

OBJECTIVE:

1. To simulate the Two Stage RC Coupled Amplifier in Multisim and study the transient
and frequency response.

2. To determine the phase relationship between the input and output voltages by
performing the transient analysis.

3. To determine the maximum gain, 3dB gain, lower and upper cutoff frequencies and
bandwidth of Two Stage RC Coupled Amplifier by performing the AC analysis.

4. To determine the effect of cascading on gain and bandwidth.

SOFTWARE TOOL:

= Multisim

APPARATUS:

Name

Range / Value

Quantity

D.C Regulated power supply

(0—30V)

Transistors

BC 107

Resistors

10KQ, 150KQ, 47K,
22KQ, 33KQ, 2.2KQ

Resistors

1KQ, 5600, 22002

Capacitors

10pF

Function Generator

CRO

THEORY:
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An amplifier is the basic building block of most electronic systems. Just as one brick does
not make a house, a single-stage amplifier is not sufficient to build a practical electronic system.
The gain of the single stage is not sufficient for practical applications. The voltage level of a signal
can be raised to the desired level if we use more than one stage. When a number of amplifier
stages are used in succession (one after the other) it is called a multistage amplifier or a cascade

amplifier. Much higher gains can be obtained from the multi-stage amplifiers.
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CIRCUIT DIAGRAM:
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OBSERVATIONS/GRAPHS:
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Scale: I 5 V/Div

Y pos.{Div): \-_187

AC

0

Channel_B
27,402 mV
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772.019 uv
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AC

Scale: [50 mV/Div
Y pos.(Div): | 1.4
0 -

Reverse

Save

Ext. trigger

Trigger
Edge:

[F]x [a]E

Level: [ 0

il

Single | Normal || Auto

None

In a multi-stage amplifier, the output of one stage makes the input of the next stage. We

must use a suitable coupling network between two stages so that a minimum loss of voltage occurs

when the signal passes through this network to the next stage. Also, the dc voltage at the output of

one stage should not be permitted to go to the input of the next. If it does, the biasing conditions of

the next stage are disturbed. Figure shows how to couple two stages of amplifiers using RC

coupling scheme.
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This is the most widely used method. In this scheme, the signal developed across the

collector resistor RC (R2)of the first stage is coupled to the base of the second stage through the

capacitor CC.(C2) The coupling capacitor blocks the dc voltage of the first stage from reaching the

base of the second stage. In this way, the dc biasing of the next stage is not interfered with. For this
reason, the capacitor CC (C2)is also called a blocking capacitor. As the number of stages

increases, the gain increases and the bandwidth decreases.

RC coupling scheme finds applications in almost all audio small-signal amplifiers used in

record players, tape recorders, public-address systems, radio receivers, television receivers, etc.

PROCEDURE:

1. Open Multisim Software to design two stage RC coupled amplifier circuit

2. Select on New editor window and place the required components of amplifier on the circuit
window.

3. Make the connections using wire and check the connections of oscillator.

4. Go for simulation and using Run Key observe the output waveforms on CRO

5. Indicate the node names and go for AC Analysis with the output node

6. Observe the Transient response and Ac Analysis for the first stage and second stage
separately and draw the magnitude response curve

7. Calculate the bandwidth of the amplifier

INFERENCE:

1. From the transient analysis, it is observed that,

2. From the frequency response curve the results observed are tabulated in table 1.

3. From the AC response, it is observed that,
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Observation points:

S. No. Parameter
1 Max. Gam in dB

2 3dB Gain

Lower Cutoft Frequency

Upper Cutoff Frequency

Bandwidth of 1 stage

Bandwidth of 2 stage

REVIEW QUESTIONS:

Why do you need more than one stage of amplifiers in practical circuits?

What is the effect of cascading on gain and bandwidth?

What happens to the 3dB frequencies if the number of stages of amplifiers increases?
Why we use a logarithmic scale to denote voltage or power gains, instead of using the

Simpler linear scale?
What is loading effect in multistage amplifiers?

EXCERSICE:

1. Design two stage amplifier using different FET transistors.
2. Design a PCB layout for the two stages RC coupled Amplifier.

**k*
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9a. TUNED VOLTAGE AMPLIFIER

Exp. No:

AIM: To obtain the frequency response of a tuned voltage amplifier.
And to obtain the band width.

APPARATUS:

S. No Name Range / Value Quantity

Transistor SL100 1

Resistors 1K@ , 22 K@, 1.8K@, 470 Each 1
Capacitors 10F, 33F 1
IF Transformer | -- 1

CIRCUIT DIAGRAM: MODEL GRAPH:

)
! 1
I 1
| |
! 1
1 |

'

10KQ %
B

Tuned Voltage Anplifier

-
f fr fy Frequency

THEORY

The amplifier is said to be class C amplifier, if the Q point and the input signal are
selected such that the output signal is obtained for less than a half cycle, for a full input cycle.
Due to such a selection of the Q point, transistor remains active, for less than a half cycle. Hence
only that much part is reproduced at the output. For remaining cycle of the input cycle, the
transistor remains cut-off and no signal is produced at the output. Here a parallel resonant circuit
acts as a load impedance. As collector current flows for less than half cycle, the collector current
consists of a series of pulses with the harmonics of the input signal.

A parallel tuned circuit acting as a load impedance is tuned the input frequency.
Therefore, it filters the harmonic frequencies and produce a sine wave output voltage consisting
of fundamental component of the input signal. A class C tuned amplifier can be used as a
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frequency multiplier if the resonant circuit is tuned to a harmonic of the input signal. Here class-C
amplifier is used with parallel tuned circuit. Therefore the output voltage is a maximum at the
resonant frequency. The resonant frequency for parallel tuned circuit is given as

Resonant frequency= Fr = —

2L
PROCEDURE:

. Connect the circuit as shown in the figure.

. Apply a 4 mV sinusoidal signal at a frequency of 1 KHz and note down the O/P.

. Now vary the frequency of the input signal upto 1MHz in suitable steps by keeping
the input voltage constant.

. Note down the O/P voltage Vo.

. Tabulate the readings.

. Draw gain Vs frequency graph on semilog sheet and determine the band width.

RESULT:

TABULAR FORM:
Vi=5mV

Frequency | Output Voltage ( Vo) GainindB
(Hz) (mV) =20 log (Vo / Vi)

»
Z
o

50

100
300
500
700
1K
3K
5K
7K
10K
30K
50K
70K
100K
300K
500K
700K
1MHz

O N OO BW N

(o]
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[N

[EY
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[EY
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[EEN
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=
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9b. TUNED VOLTAGE AMPLIFIER
Exp. No:
PREAMBLE:
Study the operation and working principle Tuned amplifier.

OBJECTIVE:

To obtain the frequency response of a tuned voltage amplifier using Multisim and to obtain
the band width.

SOFTWARE TOOL:
= Multisim

APPARATUS:

S. No Name Range / Value Quantity

Transistor SL100/BC 107 1
Resistors 1K@ ,100K@,10k@ 2,11
Capacitors 10uF,5nf,0.047uf 2,11
Inductor 50mH 1
RPS 12V 1
CRO 30MHz 1

THEORY:

Most of the audio amplifiers we have discussed in the earlier chapters will also work at
radio frequencies i.e. above 50 kHz. However, they suffer from two major drawbacks. First, they
become less efficient at radio frequency. Secondly, such amplifiers have mostly resistive loads and
consequently their gain is independent of signal frequency over a large bandwidth. In other words,
an audio amplifier amplifies a wide band of frequencies equally well and does not permit the
selection of a particular desired frequency while rejecting all other frequencies. However,
sometimes it is desired that an amplifier should be selective i.e. it should select a desired frequency
or narrow band of frequencies for amplification.

For instance, radio and television transmission are carried on a specific radio frequency
assigned to the broadcasting station. The radio receiver is required to pick up and amplify the radio
frequency desired while discriminating all others. To achieve this, the simple resistive load is
replaced by a parallel tuned circuit whose impedance strongly depends upon frequency. Such a
tuned circuit becomes very selective and amplifies very strongly signals of resonant frequency and
narrow band on either side. Therefore, the use of tuned circuits in conjunction with a transistor
makes possible the selection and efficient amplification of a particular desired radio frequency.
Such an amplifier is called a tuned amplifier. In this chapter, we shall focus our attention on
transistor tuned amplifiers and their increasing applications in high frequency electronic circuits.
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CIRCUIT DIAGRAM:

L1
50mH

Cc2

I
+IL

BC107BP

Re J Ce
1KQ T\10;1F

TUNED VOLTAGE AMPLIFIER

OBSERVATIONS/GRAPHS:

VA

TATATATAY

. Time Channel_A Channel_B
B a2l 5 913s 13.834mV 6.932mV
[ ¢ = 21185 13.834mV 6.932mV
|T2T1 || S5.000ms -8.945pV 43,836V

Timebase Channel A
Scale: | 2ms/Div Scale: ! 50 mV,Div

Scale: '10 mV /Div Edge: [£]% [_T_] Sl
X pos.(Div): | O Y pos.(Div): | -1.8 Y pos.(Div): | 1.6 Level: Io vV |
[v/r]add|/a [aB | [ac o [DC] ac|[o |[oc] -

Input and Output waveforms

<

Save )
Ext. trigger

Channel B Trigger

Single | Normal Auto None]
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Amplifiers which amplify a specific frequency or narrow band of frequencies are called
tuned amplifiers. Tuned amplifiers are mostly used for the amplification of high or radio
frequencies. It is because radio frequencies are generally single and the tuned circuit permits their
selection and efficient amplification. However, such amplifiers are not suitable for the
amplification of audio frequencies as they are mixture of frequencies from 20 Hz to 20 kHz and
not single. Tuned amplifiers are widely used in radio and television circuits where they are called
upon to handle radio frequencies. Below figure shows the circuit of a simple transistor tuned
amplifier. Here, instead of load resistor, we have a parallel tuned circuit in the collector. The
impedance of this tuned circuit strongly depends upon frequency. It offers a very high impedance
at resonant frequency and very small impedance at all other frequencies. If the signal has the same
frequency as the resonant frequency of LC circuit, large amplification will result due to high
impedance of LC circuit at this frequency. When signals of many frequencies are present at the
input of tuned amplifier, it will select and strongly amplify the signals of resonant frequency while
rejecting all others. Therefore, such amplifiers are very useful in radio receivers to select the signal
from one particular broadcasting station when signals of many other frequencies are present at the
receiving aerial.

PROCEDURE:

1. Open Multisim Software to design circuit
2. Select on New editor window and place the required component on the circuit
window.
3. Make the connections using wire and check the connections and oscillator.
. Go for simulation and using Run Key observe the output waveforms on CRO

. Indicate the node names and go for AC Analysis with the output node

. Observe the Ac Analysis and draw the magnitude response curve

. Calculate the bandwidth of the amplifier

RESULT &DISCUSSION:

1. Frequency response of single tuned Amplifier is pSetted.

2. Gain = dB (maximum).

3. Bandwidth= (fH—fL) =
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Frequency Response:

Theoretical calculations:
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10a. DARLINGTON PAIR AMPLIFIER
Exp. No: Date:

AIM: Perform the frequency response of a Darlington amplifier. Calculate gain. Calculate
bandwidth.

COMPONENTS REQUIRED:

1. Transistor (NPN, Si) BC 547 : 2 Nos.

2. Electrolytic Capacitor 10 uF : 2Nos.

3. Carbon film Resistors 82 kQ, 22 kQ, 2.2 kQ, 390 Q, 1 kQ : 1 No. each
MEASURING INSTRUMENTS:

1. 20 MHz Dual trace CRO : 1 No.

2. 1 MHz Function Generator : 1 No.
MISCELLANEOUS:

1. Trainer Module : 1 No.

2. 0-30V,1ADC Power Supply: 1 No.

3. Connecting wires .1 Set.

CIRCUIT DIAGRAM:

c2
—-

A0pk

BCS4TRP

3 SmVpk
§ o Mz
i g

THEORY:

In Darlington connection of transistors, emitter of the first transistor is directly connected
to the base of the second transistor. Because of direct coupling dc output current of the first stage
is (1+hfe)lb1. If Darlington connection for n transistor is considered, then due to direct coupling
the dc output current for last stage is (1+hfe)" times Ib1. Due to very large amplification factor
even two stage Darlington connection has large output current and output stage may have to be a
power stage. As the power amplifiers are not used in the amplifier circuits it is not possible to
use more than two transistors in the Darlington connection.

In Darlington transistor connection, the leakage current of the first transistor and overall
leakage current may be high, which is not desired.
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Tabular Form:

Vi=20mV
S.No | Frequency (Hz) | Output VVoltage Voltage Gain Gain indB
(Vo) (Av)=Vo/Vi. Av=20log(Vo/Vi)

50

1K
3K
5K
7K
10K
30K
50K
70K
100K
300K
500K
700K
1MHz

O O N O BWIN|PF

PROCEDURE:

. Connect the circuit as shown in figure.

. Apply supply voltage Vcc=12 V
Keep Vi=20 mV by keeping frequency of function generator at 1kHz.

. Keep input constant throughout the experiment.

. Vary the input frequency 50 Hz to 1 MHz and note down the output voltage.
Calculate the gain of the amplifier in decibels using the formula gain in

dB=20log(Vo/Vi).
7. PSet the graph between frequencies Vs Gain.

RESULT:
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Exp. No:

10b. DARLINGTON PAIR AMPLIFIER (Using Simulation)

Date:

AIM: Perform the frequency response of a Darlington amplifier. Calculate gain. Calculate
bandwidth using Simulation.

CIRCUIT DIAGRAM:

c1
11
11

10pF

v tacs.tgm _
Fa5mVpk :
L ke LR2
""—;"! ‘.}_ \.3

-

Oscilioscops-XSCT

1 &2 00005 0000
S W 0000 0.000
T2-T1 0000 0000y

Torebore

Scala: | 2msOry

Channe A
Scaker L0 O Sealmr | 200 O
Xpos.{Dnvie | O ¥ pos.Cav): 1.5 Ypos.w): 1.5
(T | Acc DN AD AC 0 10C

ACI O 'lBC ' Type [5hg
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Tabular Form:

Vi=20mV
S.No | Frequency (Hz) Output Voltage Voltage Gain Gain indB
(Vo) (Av)=VolVi. Av=20log(Vo/Vi)

50

1K
3K
oK
7K
10K
30K
S0K
70K
100K
300K
500K
700K
1MHz

OO N0 B WIN| -

PROCEDURE:

Connect the circuit as shown in figure.
Apply supply voltage Vcc=12V
Keep Vi=20mV by keeping frequency of function generator at 1kHz.
Keep input constant throughout the experiment.
Vary the input frequency 50 Hz to 1IMHz and note down the output voltage.
Calculate the gain of the amplifier in decibels using the formula gain in
dB=20log(Vo/Vi).
7. PSet the graph between frequencies Vs Gain.

RESULT:
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11a. SERIES FED CLASS-A POWER AMPLIFIER

Exp. No:

Date:

AIM: To design a series fed class-A power amplifier in order to achieve max output ac power and

efficiency using hardware.

COMPONENTS REQUIRED:
1. Transistor (NPN, Si) BC 107
2. Electrolytic Capacitor 100 nF

: 1 Nos.
: 2 Nos.

3. Carbon film Resistors 1 kQ, 33 Q and 20 kQ: 1 No. each

MEASURING INSTRUMENTS:
1. 20 MHz Dual trace CRO
2. Multimeter
MISCELLANEOUS:
1. Power Supply 0-30 V DC
2. Bread Board
3. Connecting Wires

CIRCUIT DIAGRAM:

: 1 No.
1 2 Nos.

:1 No.
:1 No.
11 Set

V_ 100 mV
<

TABULAR FORM:

Vin=100 mV

Applied frequency Output voltage(V0)

Gain in dB=20log(\VV0/Vi)

1kHz
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THEORY:

The circuit is called “series fed” because the load RL is connected in series with transistor
output. It is also called as direct coupled amplifier. ICQ=Zero signal collector current
VCEQ=Zero signal collector to emitter voltage power amplifiers are mainly used to deliver more
power to the load. To deliver more power it requires large input signals, so generally power
amplifiers are proceeded by a series of voltage amplifiers. In class-A power amplifiers, Q-point
is located in the middle of DC- load line. So output current flows from complete cycle of input
signal. Under zero signal condition, maximum power dissipation occurs across the transistor. As
the input signal amplitude  increases power dissipation reduces. The maximum theoretical

efficiency is 25%.

CALCULATIONS:
Take RL=RC=220 Q

Voip—pi)
2Ry

2. AC output power Pac= ':

3. Efficiency n =2ac v 394=
Ppc
PROCEDURE
1. Connect the circuit diagram and supply the required DC supply.
2. Apply the Ac signal at the input and keep the frequency at 1 kHz and connect the
power output meter at the output. Change the load resistance in steps for each value of
impedance and not down the output power.

PSet the graph between o/p power and load impedance. From this graph find the
impedance for which the o/p power is maximum. This is the value of optimum load.

Select load impedance which is equal to 0 V or near about the optimum load. See the
waveform of the o/p of the CRO.

Calculate the power sensitivity at a maximum power o/p using the relation.

The maximum input signal amplitude which produces undistorted output signal is

The practical efficiency of the circuit is

RESULT:
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11b. SERIES FED CLASS-A POWER AMPLIFIER (Using Simulation)

Exp. No: Date:
PRELAB:
Study the classification and operation of Small signal and large signal amplifier.

OBJECTIVE:
To observe input and output power of class A Power amplifier, and also calculate

Bandwidth.

SIMULATION TOOL.:
= Multisim

APPARATUS:

S. No Name Range / Value Quantity

D.C Regulated Power Supply (0-30V)

Resistors 100K, 560Q2, 470Q
Capacitors 2.2uF ,100uF
Inductor 1mH

CRO --

Watt meters --

THEORY:

The amplifier is said to be class A power amplifier if the g point and the input signal are
selected such that the output signal is obtained for a full input cycle. For this class the position of q
point is approximately at the mid-point of the load line. For all the values of input signal the

transistor remains in the active region and never entire into the cutoff or saturation region. The

collector current flows for 360° (life cycle) of the input signal in other words the angle of the

collector current flow is 360° the class a amplifiers or furthers classified as directly coupled and
transformer coupled and transformer coupled amplifiers in directly coupled type .The load is
directly connected in the collector circuit while in the transformer coupled type, the load is coupled
to the collector using the transformer.

Advantages:

1. Distortion analysis is very important
2. It amplifies audio frequency signals faithfully hence they are called as audio
amplifiers
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CIRCUIT DIAGRAM:

=

| R2 (L1 [
S100k0) Jimit =
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+

Rt ‘
e 1
Y00 v
[ [ v — ‘jl “ ‘ 7‘1

IBC107BP

2.5
| f 100mYms "
{ o~ 0kHz
| _7/ o

Observations and Graphs:

Input and Output waveforms

Disadvantages:

1. H parameter analysis is not applicable
2. Due to large power handling the transistor is used power transistor which is large in size
and having large power rating
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he screen and then draw the circuit
on the screen with the help of

. Connect the WATTMETERS on
both input and output side.

. The input terminal is connected to
one terminal of CRO and output to
other

. Start the simulation and observe
the input and output waveforms.

. Note down the values of input and
output powers from Watt meters.

CALCULATIONS:

—

Efficiency (Pac/ PDC) =

D@ =

P ac =Vcclc ; Poc =Vm/2R. =
V2pp/8RL

%) = Pac/ Poc X 100

RESULT & DISCUSSION:
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12a.
CLASS-
B PUSH
PULL
AMPLI
FIER

AIM: To PSet the Graph between Load and Power of a Class B Push pull Power
Amplifier.

APPARATUS:

Push pull power amplifier module
D.C Regulated Power supply (0-30V).
Function generator

CRO

AAD
vV

circUIT 'ISTACIEJRNM: L

100pF l'/ g
| .' }:C\DS‘ OQupad Transhrmes
“~ ‘ <. :: & l
WRN 5= KNS TTW0UF @ <5
- o -~

F 'IT(mus

Clase B Pusk Pull Awgliffer

Output &

MODEL GRAPH: Power
indBm

048

A
/o

Load Resistance, RL

=
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TABULAR FORM:

Output Power Power in db
Po (MW) (10 log PO)

PROCEDURE:

Connect the circuit diagram as shown in the figure.

Determine the maximum signal handling capacity of the push pull amplifier.
Apply sinusoidal signal of 4mV peak to peak voltage at a frequency of 1 kHz.
Connect Power meter at the O/P terminals.

By changing the load at the O/P terminals measure the power in the Power
meter.

Tabulate the readings.

pSet the graph between Power vs load

RESULT:

VIVA QUESTIONS:

1. What is meant by conversion efficiency? Which type of power amplifier has
the maximum conversion efficiency? Why?

2. To which class does the push-pull amplifier belongs and what are the
advantages of it?
What is meant by crossover distortion? In which power amplifier it is
maximum?
Why class-A amplifier is used in transmitter modulators?
What is the maximum theoretical efficiency of a class-A amplifier?
Which harmonics are eliminated in the class —B push-pull amplifier?
What is meant by complementary symmetry push-pull amplifier? State its
advantages.
Why the load is to be coupled through a transformer in a class-A amplifier?
Discuss the stability techniques of power amplifier?
Draw the thermal equivalent circuit of a power amplifier?
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12b. CLASS-B POWER AMPLIFIER

Exp. No:

PRELAB:
Study the operation of Class B Power amplifier
Identify various distortions occurred in Class B
Identify the different ways to avoid Distortions in class B power amplifier

OBJECTIVE:
To observe input and output power of class B Power amplifier, and also calculate

Bandwidth.

SIMULATION TOOL.:
= Multisim

APPARATUS:

S. No Name Range / Value Quantity

D.C Regulated Power Supply (0-30V) 1
Resistors 32Q 4
Capacitors 100uF, 0.5mf 2,1
CRO Dual channel 1
Watt meters -- 2

THEORY:

An amplifying system consists of several stages in cascade. The input and the intermediate
stages amplify small signal excitations to a value large enough to drive the final device .The output
stage feeds the final device .The output stage feeds a transducer such as a CRO, loudspeaker or
servomotor. Thus the final stage must be capable of delivering a large voltage or current or
appreciable amount of power. This requires an amplifier which is referred as a power amplifier

In class B complimentary symmetry class _B amplifier one n-p-n and p-n-p is used. Hence
the circuit is called class-B complimentary symmetry amplifier. This circuit is transformer less
circuit .But with common collector configuration it becomes transformer less Circuit to transfer
maximum power to load. Hence the matched pair of complementary transistors are used in
common collector configuration this is because in common collector configuration has Highest

input impedance and lowest output impedance and hence the impedance matching is possible.
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CIRCUIT DIAGRAM:

c1 ~ a1
—{ [~ NS
100} Y w

it

0 SmF

Class B Complementary Symmetry Power Amplifier

OBSERVATIONS:

Input and output waveforms
PROCEDURE:

1. Enter in to the Multisim 2013 software.

2. Customize the screen and then draw the circuit on the screen with the help of
3. Connect Two Wattmeter and CRO on both input and output side.

4. The input terminal is connected to one terminal of CRO and output to other
5. Start the simulation and observe the input and output waveforms.

6. Note down the values of VO & VI and find AC and DC power.

7. Hence find efficiency

mouse.

terminal.
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OBSERVATION:
Vo = Vce =

h=Vm

RL = Efficiency:
- Y b e

RESULT & DISCUSSION:
Frequency response:

class B Power amplifier
AC Analysis
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CIRCUIT DIAGRAM: (Class B Push pull Power)

Oupat Trans formes

Tl-(l BUuF

Claes E Purk Pull Anglifinr

MODEL GRAPH:

Output &
Power
indBm

048

/AN
/N

Load Resistance, RL

o=

TABULAR FORM:

Output Power Power in db
Po (mMW) (10 log PO)
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13a. COMPLEMENTARY-SYMMETRY CLASS-B POWER AMPLIFIER

Exp. No: Date:

AIM: To design a complementary-symmetry class-B push-pull power amplifier in order to
achieve maximum output AC power and efficiency.

COMPONENTS REQUIRED:
1. Complementary-Symmetry Class-B Power Amplifier Trainer Module

MEASURING INSTRUMENTS:

1. CRO (Dual channel) DC — 20 MHz
2. Function generator

MISCELLANEOUS:
1. Connecting cards

CIRCUIT DIAGRAM:

L=

|

Tmput from
FUNERES S aran.

|
r
.
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OUTPUT WAVEFORM:

|

THEORY:

Power amplifiers are designed using different circuit configuration with the sole purpose
of delivering maximum undistorted output power to load. Push-pull amplifiers operating either in
class-B are class-AB are used in high power audio system with high efficiency.

In complementary—-symmetry class-B power amplifier two types of transistors, NPN and
PNP are used. These transistors acts as emitter follower with both emitters connected together.

In class-B power amplifier Q-point is located either in cut-off region or in saturation
region. So, that only 1807 of the input signal is flowing in the output.

In complementary-symmetry power amplifier, during the positive half cycle of input
signal NPN transistor conducts and during the negative half cycle PNP transistor conducts. Since,
the two transistors are complement of each other and they are connected symmetrically so, the
name complementary symmetry has come.

Theoretically efficiency of complementary symmetry power amplifier is 78.5%.

PROCEDURE:

Connect the circuit has shown in the circuit diagram.

Measure base, emitter and collector D.C voltages of both transistors and compare
against estimated values.

Apply the input at input terminals of the circuit from the function generator.

Keep the input signal at constant frequency under mid frequency region and adjust
the amplitude such that output voltage undistorted.

Calculate the power efficiency and compare it with theoretical efficiency.
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OBSERVATIONS:

Efficiency is defined as the ratio of AC output power to DC input power

DC input power = VCC x ICQ; AC output power = VP-P2/8RL

CALCULATIONS:

Input DC power = VCC X ICQ;
Output AC power = Vrms X Irms= VPP2 / 8RL,

Untput AL pawrar

n= Input UL power

RESULT:
The maximum input signal amplitude which produces undistorted output signal is

The practical efficiency of the circuit is
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13b. COMPLEMENTARY-SYMMETRY CLASS-B POWER AMPLIFIER
(Using Simulation)

Exp. No: Date:

AIM: To design a complementary-symmetry class-B push-pull power amplifier in order to
achieve maximum output AC power and efficiency by using Simulation software

CIRCUIT DIAGRAM:

——

I
At

OUTPUT WAVEFORM:

% Oscilloscope XSC1

Chasred A ;o B
Sl - e -—:-; e 6 Al

A pomten |-|)—"— B ¥ pacten |J J - t fpanken |3

Y4 | A | as & o J0C { o 0 foc
! .
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THEORY:

Power amplifiers are designed using different circuit configuration with the sole purpose
of delivering maximum undistorted output power to load. Push-pull amplifiers operating either in
class-B are class-AB are used in high power audio system with high efficiency.

In complementary—-symmetry class-B power amplifier two types of transistors, NPN and
PNP are used. These transistors acts as emitter follower with both emitters connected together.

In class-B power amplifier Q-point is located either in cut-off region or in saturation
region. So, that only 1807 of the input signal is flowing in the output.

In complementary-symmetry power amplifier, during the positive half cycle of input
signal NPN transistor conducts and during the negative half cycle PNP transistor conducts. Since,
the two transistors are complement of each other and they are connected symmetrically so, the
name complementary symmetry has come.

Theoretically efficiency of complementary symmetry power amplifier is 78.5%.

PROCEDURE:

Connect the circuit as shown in the circuit diagram.

Connect the signal generator output to input terminals of the circuit and Channel
— 1 of dual trace CRO.

Connect the output terminal of the circuit to Channel — 2 of the dual trace CRO.
Set the signal generator output at 1 V sine wave at 1 kHz constant and fed it to the
circuit.

Simulate the circuit and observe the output waveform

OBSERVATIONS:

Efficiency is defined as the ratio of AC output power to DC input power

DC input power = VCC x ICQ AC output power = VP-P2 / 8RL

CALCULATIONS

Input DC power = VCC x ICQ
Qutput AL poawer

Output AC power = Vrms X Irms= VPP2 /8RL, 1= [put DC powar

RESULT:
The maximum input signal amplitude which produces undistorted output signal is

The practical efficiency of the circuit is
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14a. BOOTSTRAP EMITTER FOLLOWER
Exp. No: Date:

AIM: To construct a bootstrap sweep circuit and generate a ramp voltage and to measure sweep
time 1, return time 1.
COMPONENTS REQUIRED:
1. Transistors SL 100 (Si) : 2 Nos.
2. Diode 1N 4007 (Si): 1 No.
3. Ceramic Disc Capacitor 100 pF, 10 nF : 1 No. each
4. Electrolytic Capacitor 47 puF : 1 No. each
5. Carbon film Resistors 0.25 W 100 kQ, 10 kQ and 15 kQ: 1 No. each
MEASURING INSTRUMENTS:
1. 20 MHz Cathode Ray Oscilloscope : 1 No.
MISCELLANEOUS:
1. 1 MHz Signal generator : 1 No.
2. Regulated DC power supply (0-30 V) : 1 No.
3. Bread board Trainer Module : 1 No.
4

. Connecting wires : 1 Set

CIRCUIT DIAGRAM:

IN 4007

Bootstrap Sweep Generator
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THEORY:

The bootstrap sweep generator uses the following principle in its functioning and
generates the ramp voltage: The transistor ¢4 acts as ON-OFF switch. @z is emitter
follower. Input ¥; IS a pulse voltage or rectangular wave. When inpgt is positive
transistor @gcomes ON i.e. it goes into saturation. Emitter of is ¢hupled to collector of
#; through capacitor Lz

When the input V; goes negative, %;becomes OFF, the potential at the collector terminal of &4
rises. This increase of voltage at this point is transmitted to B through ¢ and capacitor Lz.

The result is that the potential of B also arises by the same amount. This is the principle of bootstrap.
PROCEDURE:

1. Rig-up the circuit on the bread board as per the circuit diagram.
2. Apply6V V¢, 8V Vgg from the dual channel DC regulated power supply.

3. Apply 4 Ve_z square wave from the function generator to the circuit and
channel | of dual trace CRO.

4. Connect the circuit output to channel 11 of dual trace CRO.
. Measure the peak to peak output ramp voltage, sweep time 1, return time
1, from the output waveform.
6. Compare the practical values with the theoretical values.

. Draw the input and output waveforms on the graph.

Observations
1. 1S5 =
2. Tr =

Qutput ramp vaoltage (V) =

4 Veriar Ve (V) =

[CE[sar)

RESULT:
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14b. BOOTSTRAP EMITTER FOLLOWER (Using Simulation)

Date:
Exp. No:

AIM: To cor}%truct a bootstrap sweep circuit and generate a ramp voltage and to measure sweep
time ~,returntime  using Simulation.

CIRCUIT DIAGRAM:

Bootstrap Sweep Generator

OUTPUT WAVEFORM:

VAR
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THEORETICAL CALCULATIONS
Sweeptime= dg,Returntime = i,
e =R R=15kQ, C=10nF

Cus

™%

v (72 7)

hye, = 150

PROCEDURE

1. Rig-up the circuit on the bread board as per the circuit diagram.
. Apply 6V Vec, 8V Vzz from the dual channel DC regulated power supply.
3. Apply 4 ¥r_, square wave from the function generator to the circuit and channel
| of dual trace CRO.
4. Connect the circuit output to channel Il of dual trace CRO.
. Measure the peak to peak output ramp voltage, sweep time 1, return time
1., from the output waveform.
6. Compare the practical values with the theoretical values.

. Draw the input and output waveforms on the graph.

1.75 =
2. Tr =
3. Qutput ramp voltage (V)

4,0 - ".":I Lt (V) =

RESULT:
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Simulation Procedure:

PROCEDURE for 2 stage RC Coupled Amplifier:
1. Connect the circuit as shown in the circuit diagram.

Connect the signal generator output to input terminals of the circuit and Channel — A of
dual trace CRO.

Connect the output terminal of the circuit to Channel — B of the dual trace CRO.

Set the signal generator output at 10 mV sine wave at 1 kHz constant and fed it to the
circuit.

In the Simulation tab go to analysis - AC analysis. Set the starting frequency as 20 Hz
and Stop frequency 10 MHz, vertical scale as linear and no. of points per decade 1000.

In the output tab select Add expression write formula as 20*log((\VO)/(V1)) in the
expression field. Select OK and Simulate.

Select the cursers and find the FH and FL from the frequency response to find out the
bandwidth.

PROCEDURE for Class —C Tuned amplifier:
1. Connect the circuit as shown in the circuit diagram.
Connect the output terminal of the circuit to Channel — A of the dual trace CRO.

In the Simulation tab go to analysis - AC analysis. Set the starting frequency as 10
kHz and Stop frequency 30 kHz, vertical scale as linear and no of points per decade
equal to 1000 and simulate.

Select the cursers and find the FT from the frequency response to find out the tuned
frequency.

PROCEDURE for RC Phase shift & Wein Bridge Oscillator:
1. Connect the circuit as shown in the circuit diagram.
Connect the output terminal of the circuit to Channel — 1 of the dual trace CRO.

Simulate, adjust the potentiometer (i.e., 12 kQ variable resistance) to get the correct
sine wave form. Place the both cursers in the CRO observe the T2—- T1 as T.

PSet the graph for the obtained frequency

PROCEDURE for Shunt and Series Voltage Regulators:
1. Connect the circuit as shown in the circuit diagram.
Connect the output terminal of the circuit to Voltmeter.

In the Simulation tab go to analysis - DC Sweep. Set the starting value to 0 Volts and
stop value 20 Volts, Steps 0.5 Volts and simulate.

Select the curser to find out the output voltage for the applied voltages. Note down
the voltages in the respective tabular formi.e., Vin and Vout).

Repeat the step 4 for all the desired RL.
PSet the graph Vin Vs Vout
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INTRODUCTION TO MULTISIM

Multisim is the schematic capture and simulation program designed for schematic entry,
simulation, and feeding to downstage steps, such as PCB layout. It also includes mixed
analog/digital simulation capability, and microcontroller co-simulation.

Ultiboard is used to design printed circuit boards, perform certain basic mechanical CAD
operations, and prepare them for manufacturing. It also provides automated parts placement and
layout.

Multisim User Interface: Multisim user interface includes the following elements:

Multisim User Interface

Multisim’s user mterface mncludes the following elements:

M j) D@D ® ®

W |Settng Zeared 2 0 42]«. {Cetang Liartnd 2 T l’ W

fie ot Vew lu‘ MU Simutste . Tiappte os feootts Cptions (mIv- Help Y

Ners | a8 eloe |08 | (REBE-E 5 S Y nust.
> - A BWghIo=RYB¥ED %I D e |EHCE
Design Tiu I,vx‘n" e
LE Jd <
= 9 Decgnl voo
#:_ﬂJom_:nl ) | w

¥ Cetting Staned §
| ol/
benvse
| oo - :
o ISOMVM Y

= ||
o

=
£ Dering Started 2
[« hwe Gy

Ll

Coarter Conied
vee

Tw

S PR P RLE R RERS ELEERIER

5

ety [y | rivect ven || [ Dol | [B) Getting Stanea |

T Boom v

S

Reles Jeat Secton  Pamly Vabe Todawe “ewfstwe Matant Coovdrexe 2/ Fottion
=1 Cattrg. cons. pe-risy CapC 1t e Fotated 90
Q Cetbry, [0 N S U o IPC-2251 O C1210 7 Rotsted 90
o Cetuy, CAP T, DG PC-7I0L i<z 05 Ftsled 0
a0 ety , PR, -~ Urony
A E

LEE AR A1 Comporwate | COU0 Hyers '-vnug'rr]

mashew View

3y

Menu Bar View Toolbar 9 Instruments Toolbar
Dasign Toolbox Simutation Toolbar 10 Workspace
Component Toolbar Main Toolbar 11 Spreadsheat View
Standard Toolbar In Use List 12 Active Tab
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Refer to the table below as needad:

Element Description
Meru Ba Conzains the comuuands for all fupctions.

Desiegn Use to mavigate ttwonph the different types of files in a project
Toolbox (schematics, PCBs. reponts), view a scliematic s keerachy md
show or hide diffevent fayers

Cowponentr | Conrxng Lomons (Bal vou vse 10 siedt components fFom the
toolbar Multisim databases for placement in yous schematic

Standard Contatns buttons for commonty-performed faactions such as Save,
toolbar Print. Cut, and Pasre

View wolar | Contans umons for modifying the way the screen 15 dusplayed

Simulation Contains buttons for stasting, stopping, and otber sarmiztion
toolbar factions

Main roolbar | Contams bumens for coaranon Mulnisun fmctioas

In Use Lisr Contains a 1551 of all components nsed in the design

Instruments | Contmns busons for eack wstnmnent.
100l
Woekspace Tl s wisere yo butkd vour Gesigns.

Spreadsheet | Use for fast adwanced wewnmg and editing of paranseters tneinding
View conrpodient decals such as footpsins, RefDes, arribures and design
constramms

Actyve 1ab Indecates the design you are workmg on. Clek another tab to
switch

Schematic Capture

In the folRowiog sections, yoo will piace and wire (he compoenss i Me desiga shown belom

B Oy P e Stee Bewg beeend

T e R e el o e el =
| O@w S0 BUe RAanB AENE O U mT s,
Z_-v'-xx}f,‘-f".;..-'l_u‘v-lv9'08’-( W he N

-
b Are b -

HULHAGIAm S 144U NG

:

a

iﬂn—tun—u

Llarhoy o 2

2.

Creating the File
Complete the following steps to aeate the desapn file:
1. Lwsanch Muliistm
Ablank file called Das L gn ! opens on the warkspace.
Select FilexSave as to display a standard Wiadows Save dialog

Nastgate to the locatios where you wish o sive the file enferNyGoattingStar tadas the
File mame. and click the Save bumon
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Placing the Components

Complete the following steps to place the components on MyCettingStarted:

1. Select Place»Component to display the Select a Component dialog box.

2. Select the Indicators component Group and the HEX DISPLAY component Family.

3. Type seven seg _decimal_com_a_blue in the Component field.
As you type, the string appears in the Searching field at the bottom of the browser. Matches
display in the Component list.

Click OK when the desired component displays as shown below.
The component appears as a ~ghost™ on the cursor.

| Select a Componant (E=S m

Database: Component: Symbol (ARST v32.2)  E—-
Mast=r Catzbas= vJ seven_seg_cdeomal_com_a_bus | %) l

Grow:
Bl rndas -
Family:
-«:Ni famibes >
& voomeTes
12 nETER

Bl er08e

L NBUZZER Funchon:

0 Lame 7 SEGMENT DISPLAY, WiTTH DECIMAL
POINT COMMON AICCE

Bl veoua e YF = 3.45/ @ XimA

HEX_DISPLAY
(W] sarcraps Macel manufacturer/iD:

ENENC / SEVEN SEG [

Foatpant manufacturer rype

Genenc / TSEGECIP 146
Genaric / DISFL105

Hyperirk:

Components 1 Searching: seven_seg_decimal_com_a_blus Filter: off

5. Move the cursor to the bottom-right of the workspace and click to place the component.
Note that the Reference Designator for this component 1s U1
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6. Place the remaining components in the Digital Counter area as shown below.

Tip The Group and Family location of each component is listed in Component
B Locations.

RPACK 7

TIITrrirm
A
=
;l o
~TEN o LT
LA % BP0 |
PRRTS “RCO

13 - = I J
» 1% —
el PO R TALS47TN
<7 GND 74LS190N

kb b

Tip While placing the 200 Q resistor. press <Ctrl-R> to rotate it to a vertical
orientation

7. Place the components in the Counter Control section as shown below:.

viC

T sv

Key = Space

Jz

3=
— p—

Key - Space
—-GND

N

8. Right-click on each SPDT switch and select Flip horizontally.
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0. Place the components in the Analog Amplifier section as shown below. rotating as needed.

Ve

1 3 |
4 0.2 Vpk {m
(~ )iz S0
7 DDey 1 5%

10. Double-click on the AC voltage source (V1). change Voltage (Pk) to 200 mV and click OK
to close the dialog.

11. Place the components in the Bypass Capacitors section as shown below.

VCC vcC

T v T v

[ | C2 C3
:J.I..'hll .:=‘10nl :-J‘I.:DUM

-+ <LGhn

12. Place the header and associated components as shown below.

1 | 5V

e
o
y o .

lHDRI x4
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Component Locations

The following shows you where to locate all components for this design in the Select a

Component dialog box.

Tip Reference Designators (for example. Ul. U2) are assigned in the order the
N components are placed. If you place components in a different order than in the
original design the numberning will differ. This will not affect the operation of the

design in any way.

Component

Group

Family

VCC
GND - DGND
GROUND

Sources

POWER_SOURCES

LEDI - LED blue

Diodes

DIODES VIRTUAL

Ul - 7-segment display

Indicators

HEX DISPLAY

U2 - 74LS190N
U3 - 74LS47N

TTL

74LS

R1-200Q

RESISTOR

R2 - 1 k potentiometer

POTENTIOMETER

R3-1k

RESISTOR

R4 - 10Lmne Bussed

RPACK

J1.J2-SPDT

SWITCH

U4-741

OPAMP

V1-AC VOLTAGE

SIGNAL VOLTAGE_SOURCES

Cl-1pF
C2-10nF
C3-100 uF

CAP ELECTROLIT

J3-HDRI1X4

HEADERS TEST
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Wiring the Design
All components have pins that you use to wire them to other components or instruments. As soon
as your cursor 1s over a pin. the pointer changes to a crosshair. indicating you can start wiring.

Tip You can wire the design that you placed on the workspace or you can use
CGetting Started 1 from the Cetting Started folder (found inside the
samples folder).

Complete the following steps to wire the design:

1. Click on a pin on a component to start the connection (your pointer fums info a crosshair)
and move the mouse.

A wire appears, attached to your cursor.
Click on a pin on the second component to finish the connection.

Multisim automatically places the wire. which conveniently snaps to an appropriate
configuration. as shown below.

bkl PERE

,‘
-

74LS190N

Tip You canalso control the flow of the wire by clicking on points as you move the

mouse. Each click “fixes™ the wire to that point.

Dept.of ECE Il (B.Tech) ECE,II-SEM :: ECA-Lab




92

Finish wiring the design as shown below.

Vi
L
Rt LS
(~ w2y
=

<

Coames Canr ol
il

ma

oy |
LTI b —
o w

I

=4

JILS o

Simulation

Simulating vour designs with Multisim catches errors early in the design flow. saving time and
money.

Virtual Instrumentation
In this section. you will simulate the design and view the results with the virtual oscilloscope.

Tip Youcanalsouse Cetting Started 2 fromthe Cetting Started folder
(found 1n the sampl es folder).

1. Setup the interactive keys for J1. J2 and R2:
a. Double-click on each and select the Value tab.
b.  Select “E” for J1 and “L" for J2 in the Key for toggle field.
c. Select “A” in the Key field for R2.

Note J1.J2 and R2 are interactive components.

2. Press <E> to enable the counter.
Or
Click on the widened switch arm that appears when you hover the cursor over J1.
Enable 1s Active Low.
Select SimulatesInstruments»Oscilloscope to place the oscilloscope on the workspace.
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Complete the following steps fo create a BOM (bill of materials) for your design:
1. Select Reports»Bill of Materials.
The report appears. similar to this:

Biil of Msterias (From Document: Getting Started 2)
CEEIECE

Quantty l Desaphon Fackage
APACK_YARIABLE_ZX7, 18309 IPC-2221A/2222\D1P-14
SEVEN_SEG_DECIMAL_COM_A_BLLE Gerenc\7SEGEDIP 104
745, 7454 IPC-1221A/2220\N0 16

CAP_ELECTROLIT, |F
CaR_BLECTROUT, 10nF
CaF ELECTROLIT, 100F

PG -7351'Chp-C 1210
IPC-7351\Chp-C 1210
IPC-7354\ChipC 1210

1

1

1

1

1

1

1 GENERIC, HCR1X4 3 Gerenc'HOR IXa

2 SWITCH, SPOT Garenc'GPOT

1 LED biue Uthoard EDSR2 5VD
1 RESISTOR, k2 5% 1PC-7351'ChpR0805
1 POTENTIOMETER, S0k ’ Ganenc{ IN_POT

1 RESISTOR, 2000 5% IPC-7351\ChipR3805
1 OPAMP, 741 y IPC-2221A/2222\D1P-8
1 745, 7A 5190 1PC-2221A/222708016

Click the Send to printer button to print the Bill of Materials. A standard Print dialog box
appears. where you choose the printer. number of copies. and so on.

=

Click the Save to rext file button to save the Bill of Materials. A standard Windows file save
dialog box appears. where you specify the path and file name.

Because the Bill of Materials is primarily intended to assist in procurement and manufacturing,
it includes only “real” components—it excludes components that are not real or available for
purchase, such as sources or virtual components. Components without assigned footpnints do not
appear in the Bill of Matenals.
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Grapher View JEET) 5
File Edit ‘tew Graph Trace CQursor Legend Tools Help

& W EENED A QA RN A AL DD .

| Az Anstyos (OsolscweRsCa |

Getling Started Final

The Postprocessor

Use the Postprocessor to manipulate the output from analyses and plot the results on a graph or
chart. Types of mathematical operations that can be performed on analysis results include
arithmetic, trigonometric. exponential, logarithmic. complex, vector and logic.

Reports

You can generate a number of reports in Multisim: Bill of Materials (BOM). Component
Detail Report. Netlist Report. Schematic Statstics. Spare Gates and the Cross Reference
Report.

The following section uses the BOM as an example for the tutorial design.

Bill of Materials

A bill of materials lists the components used in a design. providing a summary of the
components needed to manufacture the circuit board.

Information provided for each component includes:
*  quantity required.

*  description. including the type of component (example: resistor) and value
(example: 5.1 kKQ).

Reference Designator.
package or footprint name.
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Analysis

In this section, you will use AC Analysis to verify the frequency response of the amplifier.

Complete the following steps to perform an AC Analysis at the output of the op-amp:
1. Double-click on the wire that is attached to pin 6 of the op-amp.
The Net Properties dialog box displays.
Change the Preferred net name to analog_out.
Select Simulate»Analyses» AC analysis»Qutput fab.
Highlight V (analog_out) in the Variables in circuit (left) column and click Add.
V(analog_out) moves to the Selected variables for analysis (right) column.
This indicates that the voltage at node V (analog_out ) will be displayed after simulation.
Click Simulate.
The results of the analysis appear in the Grapher.

Cragher View

Fle ESt Yiew Greph Trece Cumcr Legend Tocks

= > By o | [0 ()|

Getting Started Final
AC Analysis

Frequaccy (Hz)

Uk

Frequancy (H2)

wcted TraceVierwlog ous)

The Grapher

The Grapher is a multi-purpose display tool that lets you view. adjust, save and export graphs
and charts._ It 1s used to displav the results of all Muitisim analvses in graphs and charts. and
graphs of traces for some instruments (for example. the oscilloscope).

omplete the following steps to view results of a simulation on the Grapher:

C
1. Run the simulation with the oscilloscope as described earlier.
2

Select View»Grapher.
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4. Wire the instrument as shown in step 7.

@ Tip To differentiate between traces on the oscilloscope. right-click on the wire
connected to the scope’s B input and select Segment color from the context menu
that displays. Select a color that differs from the wire connected to the A mput. for
example blue. (Changing wire color or performing other editing functions cannot be
done while simulation is running).

Double-click on the oscilloscope icon to show ifs instrument face.
Select Simulate»Run.

p

The output of the op-amp appears on the scope.
Adjust the Timebase to 2 ms/Div and Channel A’s Scale to 500 mV/Div.

The followimng displays on the oscilloscope:

Oicillsazape-X5SLC1

| . Tres Charred A Crarvwd B —~——
;; [Labn 0] It a.c00v G0 5NN [ Qgaess |
&%} pocos 9.000 ¢
S

2T || oxor 0,000 ¥ 0oy =

Tinebase anel A Cravel 8 Trigge

Seake  2ralDie S 500 WD Sce; 5 VDA sage ‘]}_ [&,ﬂ&
Npoe D) 0 Y oos. D) 0 Yoos (D) 0 Leved ¢ v
| s ol v (el v (el e e

As the design simulates, the 7-segment display counts up and the LED flashes at the end of

each count cycle.

Do the following:

a.  Press <E> while the simulation is running to enable or disable the counter. Enable is
Active Low.

b. Press <L> to load zeros into the counter. Load is Active Low.
Press <Shifi-A> to observe the effect of decreasing the potentiometer’s sefting.
Repeat. pressing <A™ to increase.
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3. Finish wiring the Digital Counter section as shown below.

VCC

5V

| LT
FLI

TALS4TN

LGND
| v 74LS190N

Tip UseBus Vector Connect to wire multi-pinned devices like U3 and R4 together
in a bus. Refer to the Multisim Help for details.

Tip Virtual Wiring—To avoid clutter. you can use virtual connections between the

Counter Control and Digital Counter sections using on-page connectors. Refer to the
Multisim Help for details.
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